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Introduction to the manual

What this chapter contains
This chapter describes the target audience, purpose and contents of this manual. 

Applicability
The manual is compatible with  ACSM1-04 and ACSM1-04LC drive modules of frame 
sizes from A to E.

Safety instructions
Follow the safety instruction given in ACSM1-04 Drive Modules (0.75 to 45 kW) 
Hardware Manual (3AFE68797543 [English]). The main instructions are repeated 
below.  

WARNING! Ignoring the following instructions can cause physical injury or death, or 
damage to the equipment.

• Only qualified electricians are allowed to install and maintain the drive.

• Never work on the drive, motor cable or motor when main power is applied. 
After disconnecting the input power, always wait for 5 min to let the intermediate 
circuit capacitors discharge before you start working on the drive, motor or 
motor cable. 

Always ensure by measuring with a multimeter (impedance at least 1 Mohm) 
that:

1. voltage between drive input phases U1, V1 and W1 and the frame is close to 
0 V.

2. voltage between terminals UDC+ and UDC- and the frame is close to 0 V.

3. voltage between terminals R+ and R- and the frame is close to 0 V.

• Do not work on the drive when the permanent magnet motor is rotating. Also, 
when the supply power is switched off and the inverter is stopped, a rotating 
permanent magnet motor feeds power to the intermediate circuit of the drive 
and the supply connections become live. See the hardware manual for 
precautions before installation and maintenance work on the drive. 

• Do not work on the control cables when power is applied to the drive or to the 
external control circuits. Externally supplied control circuits may cause 
dangerous voltages inside the drive even when the main power on the drive is 
switched off. 
Introduction to the manual
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Target audience
This manual is intended for people who plan the drive application control, 
commission, use, and service the drive with fieldbus communication. Read the 
ACSM1 firmware and hardware manuals before working on the drive.

You are expected to know the fundamentals of electricity, wiring and electrical 
components as well as drive control methods, fieldbus communication concepts and 
function block programming.

Purpose of the manual
The purpose of this manual is to show how to configure fieldbus communication with 
the drive control program parameters and, as an example, to show how the drive can 
be controlled through fieldbus by using the ABB AC500 programmable logic controller 
with PS551 Control Builder.

Contents of the manual
The chapters of this manual are briefly described below.

Introduction to the manual introduces this manual.

Fieldbus control description describes how the drive can be controlled by external 
devices over a communication network.

Starting up the FPBA-01 adapter for different communication profiles presents the 
steps to take during the start-up of the FPBA-01 PROFIBUS DP Adapter Module with 
the drive. 

Starting up fieldbus communication and programming the ABB PLC (one-drive 
system) presents the steps to take during the start-up of the drive fieldbus control with 
ABB AC500 PLC and PROFIBUS DP adapter module. A system with one drive is set 
up.

Starting up fieldbus communication and programming the ABB PLC (multi-axis 
systems) presents the additional steps compared to the ones in the previous chapter 
that you must take during the start-up of the drive fieldbus control with ABB AC500 
PLC and PROFIBUS DP adapter module in a multi-axis system. A system with two 
drives is set up.

Example program for a two-axis loading machine presents an example sequence 
program which controls a loading machine with two axes.

Appendix A - How to find out the serial communication parameter values of your PC? 
instructs how to find out the serial communication parameter values of your PC.

Related manuals
• ACSM1-04 Drive Modules Hardware Manual (3AFE68797543 [English])

• ACSM1-04LC Drive Modules Hardware Manual (3AUA0000022083 [English])

• ACSM1 Motion Control Program Firmware Manual (3AFE68848270 [English])
Introduction to the manual
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• ACSM1 Speed and Torque Control Program Firmware Manual (3AFE68848261 
[English])

• PROFIBUS DP Adapter Module FPBA-01 User’s Manual (3AFE68573271 
[English])

• User Manual for PS551-MC (Motion Control library for ABB PLC AC500) 
according to Technical Specification PLCopen – Technical Committee 2 – Task 
Force; Function Blocks for motion control

• User Manual for PLC Programming with CoDeSys 2.3 by 3S – Smart Software 
Solutions GmbH

• ABB AC500 scalable programmable logic controller manuals

Terms and abbreviations

Standards
IEC 61131-3:2003, Programmable controllers – Part 3: Programming languages.

Term/Abbreviation Explanation

CM572 Profibus DP Master communication module for AC500

CM575 DeviceNet Master communication module for AC500

CM578 CANopen Master communication module for AC500

CPU Central Processing Unit

FCAN-0x Optional CANopen adapter

FDNA-0x Optional DeviceNet adapter

FPBA-0x Optional PROFIBUS DP adapter

Frame (size) Size of the drive module. 

GSD Generic Station Description. A GSD file contains a description of the 
PROFIBUS DP/PA device and is provided by the device manufacturer. 
GSD files provide a way for an open configuration tool to automatically get 
the device characteristics.

PLCopen Vendor- and product-independent worldwide association for resolving 
topics related to control programming to support the use of international 
standards in this field. For more information, see http://www.plcopen.org/

PLCopen Motion 
Control Function 
Blocks

Technical Committee 2 – Task Force Motion Control  – of PLCopen 
defines libraries of Function Blocks, like the Motion Control Specification.

PROFIBUS DP PROFIBUS version for Decentralized Periphery. PROFIBUS is an open 
serial communication standard that enables data exchange between all 
kinds of automation components.

PROFIBUS PA PROFIBUS version for Process Automation.
Introduction to the manual
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Fieldbus control description

What this chapter contains
The chapter describes how the drive can be controlled by external devices over a 
communication network.

System overview
The drive can be connected to a fieldbus controller via a fieldbus adapter module. 
The adapter module is connected to drive Slot 3.

The drive can be set to receive all of its control information through the fieldbus 
interface, or the control can be distributed between the fieldbus interface and other 
available sources, for example digital and analogue inputs. 

The drive can communicate with a fieldbus controller through a fieldbus adapter 
using one of the following serial communication protocols:

– PROFIBUS DP (FPBA-01 adapter)
– CANopen (FCAN-01 adapter)
– DeviceNetTM (FDNA-01 adapter).
– Modbus/RTU (FSCA-01 adapter) or Modbus/TCP (FENA-01 adapter)
– Ethernet/IPTM (FENA-01 adapter)
– EtherCAT (FECA-01 adapter)

Fieldbus

Other
devices

Fieldbus
controller

References

Data Flow

Status Word (SW)
Actual values

Parameter R/W requests/responses

ACSM1

Slot 3

Process I/O (cyclic)

Service messages (acyclic)

Control Word (CW)

Fieldbus 
adapter 

Fxxx

Process I/O (cyclic) or
Fieldbus control description
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Setting up communication through a fieldbus adapter module
Before configuring the drive for fieldbus control, the adapter module must be 
mechanically and electrically installed according to the instructions given in the 
User’s Manual of the appropriate fieldbus adapter module.

The communication between the drive and the fieldbus adapter module is activated 
by setting parameter 50.01 FBA ENABLE to (1) ENABLE. The adapter-specific 
parameters must also be set. See the table below.

Parameter Setting for 
fieldbus control Function/Information

COMMUNICATION INITIALISATION AND SUPERVISION

50.01 FBA ENABLE (1) ENABLE Initialises communication between drive and fieldbus adapter module.
50.02 COMM LOSS 
FUNC

(0) NO
(1) FAULT
(2) SPD REF SAFE
(3) LAST SPEED

Selects how the drive reacts in a fieldbus communication break.

50.03 COMM LOSS T 
OUT

0.3…6553.5 s Defines the time between communication break detection and the 
action selected with parameter 50.02 COMM LOSS FUNC.

50.04 FBA REF1 
MODESEL and 50.05 
FBA REF2 MODESEL

(0) RAW DATA
(1) TORQUE
(2) SPEED
(3) POSITION *
(4) VELOCITY *
(5) AUTO

Defines the fieldbus reference scaling.
When (0) RAW DATA is selected, see also parameters 50.06…50.11.
* in Motion Control Program only

ADAPTER MODULE CONFIGURATION

51.01 FBA TYPE – Displays the type of the fieldbus adapter module.
51.02 FBA PAR2 These parameters are adapter module-specific. For more information, see the User’s Manual 

of the fieldbus adapter module. Note that not all of these parameters are necessarily used.• • •
51.26 FBA PAR26
51.27 FBA PAR 
REFRESH

(0) DONE
(1) REFRESH

Validates any changed adapter module configuration parameter 
settings.

51.28 PAR TABLE 
VER

– Displays the parameter table revision of the fieldbus adapter module 
mapping file stored in the memory of the drive.

51.29 DRIVE TYPE 
CODE

– Displays the drive type code of the fieldbus adapter module mapping 
file stored in the memory of the drive.

51.30 MAPPING FILE 
VER

– Displays the fieldbus adapter module mapping file revision stored in the 
memory of the drive.

51.31 D2FBA COMM 
STA

– Displays the status of the fieldbus adapter module communication.

51.32 FBA COMM SW 
VER

– Displays the common program revision of the adapter module.

51.33 FBA APPL SW 
VER

– Displays the application program revision of the adapter module.

Note: In the User’s Manual of the fieldbus adapter module, the parameter group number is 1 or A for parameters 
51.01…51.26.
Fieldbus control description
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After the module configuration parameters have been set, the drive control 
parameters (see section Drive control parameters) must be checked and adjusted 
when necessary.

The new settings will take effect when the drive is powered up the next time (before 
powering off the drive, wait at least 1 minute), or when parameter 51.27 FBA PAR 
REFRESH is activated.

Drive control parameters
The Setting for fieldbus control column gives the value to use when the fieldbus 
interface is the desired source or destination for that particular signal. The Function/ 
Information column gives a description of the parameter.

TRANSMITTED DATA SELECTION

52.01 FBA DATA IN1 
… 52.12 FBA DATA 
IN12

0
4…6
14…16
101…9999

Defines the data transmitted from drive to fieldbus controller.
Note: If the selected data is 32 bits long, two parameters are reserved 
for the transmission.

53.01 FBA DATA 
OUT1 … 53.12 FBA 
DATA OUT12

0
1…3
11…13
1001…9999

Defines the data transmitted from fieldbus controller to drive.
Note: If the selected data is 32 bits long, two parameters are reserved 
for the transmission.

Note: In the User’s Manual of the fieldbus adapter module, the parameter group number is 3 or C for parameters 
52.01…52.12 and 2 or B for parameters 53.01…53.12.

Parameter Setting for 
fieldbus control Function/Information

CONTROL COMMAND SOURCE SELECTION

10.01 EXT1 START 
FUNC

(3) FBA Selects fieldbus as the source for the start and stop commands when 
EXT1 is selected as the active control location.

10.04 EXT2 START 
FUNC

(3) FBA Selects fieldbus as the source for the start and stop commands when 
EXT2 is selected as the active control location.

24.01 SPEED REF1 SEL (3) FBA REF1
(4) FBA REF2

Fieldbus reference REF1 or REF2 is used as speed reference 1.

24.02 SPEED REF2 SEL (3) FBA REF1
(4) FBA REF2

Fieldbus reference REF1 or REF2 is used as speed reference 2.

32.01 TORQ REF1 SEL (3) FBA REF1
(4) FBA REF2

Fieldbus reference REF1 or REF2 is used as torque reference 1.

32.02 TORQ REF ADD 
SEL

(3) FBA REF1
(4) FBA REF2

Fieldbus reference REF1 or REF2 is used for torque reference 
addition.

SYSTEM CONTROL INPUTS

16.07 PARAM SAVE (0) DONE
(1) SAVE

Saves parameter value changes (including those made through 
fieldbus control) to permanent memory.

Parameter Setting for 
fieldbus control Function/Information
Fieldbus control description
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The fieldbus control interface
The cyclic communication between a fieldbus system and the drive consists of 16/
32-bit input and output data words. The drive supports at the maximum the use of 12 
data words (16-bit) in each direction.

Data transmitted from the drive to the fieldbus controller is defined by parameters 
52.01…52.12 (FBA DATA IN) and data transmitted from the fieldbus controller to the 
drive is defined by parameters 53.01…53.12 (FBA DATA OUT).

Fieldbus module

Fieldbus

Fieldbus network

specific
interface

DATA
OUT 2)

4)
1
2
3
…
12

DATA
IN 2)

5)
1
2
3
…
12

FBA MAIN SW
FBA ACT1
FBA ACT2

Par. 01.01…99.13

FBA MAIN CW
FBA REF1
FBA REF2

Par. 10.01…99.13

FBA profile

1) See also other parameters which can be controlled by the fieldbus.
2) The maximum number of used data words is protocol-dependent.
3) Profile/instance selection parameters. Fieldbus module specific parameters. For more information, see the 

User’s Manual of the appropriate fieldbus adapter module.
4) With DeviceNet the control part is transmitted directly.
5) With DeviceNet the actual value part is transmitted directly.

Profile
select

3)

Profile
select

3)

Parameter 
table

10.01

EXT1/EXT2
Start Func

/10.04

24.01/32.01

Speed/Torque
REF1 Sel

/32.02

24.02/32.01

Speed/Torque
REF2 Sel

/32.02

53.01/…/53.12

DATA OUT
select

52.01/…/52.12

DATA IN
select

4)

5)

1)

Cyclic communication

Acyclic communication
See the manual of the fieldbus 
adapter module.
Fieldbus control description
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The Control Word and the Status Word
The Control Word (CW) is the principal means of controlling the drive from a fieldbus 
system. The Control Word is sent by the fieldbus controller to the drive. The drive 
switches between its states according to the bit-coded instructions of the Control 
Word.

The Status Word (SW) is a word containing status information, sent by the drive to 
the fieldbus controller.

Actual values
Actual values (ACT) are 16/32-bit words containing information on selected 
operations of the drive.

FBA communication profile
The FBA communication profile is a state machine model which describes the 
general states and state transitions of the drive. The State diagram on page 19 
presents the most important states (including the FBA profile state names). The FBA 
Control Word (2.12 FBA MAIN CW) commands the transitions between these states 
and the FBA Status Word (2.13 FBA MAIN SW) indicates the status of the drive.

Fieldbus adapter module profile (selected by adapter module parameter) defines 
how the control word and status word are transmitted in a system which consists of 
fieldbus controller, fieldbus adapter module and drive. With transparent modes, 
control word and status word are transmitted without any conversion between the 
fieldbus controller and the drive. With other profiles (e.g. PROFIdrive for FPBA-01, 
AC/DC drive for FDNA-01, DS-402 for FCAN-01 and ABB Drives profile for all 
fieldbus adapter modules) fieldbus adapter module converts the fieldbus-specific 
control word to the FBA communication profile and status word from FBA 
communication profile to the fieldbus-specific status word.

For descriptions of other profiles, see the User’s Manual of the appropriate fieldbus 
adapter module.

Fieldbus references
References (FBA REF) are 16/32-bit signed integers. A negative reference 
(indicating reversed direction of rotation) is formed by calculating the two’s 
complement from the corresponding positive reference value. The contents of each 
reference word can be used as torque or speed reference.
Fieldbus control description
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When torque or speed reference scaling is selected (by parameter 50.04 FBA REF1 
MODESEL / 50.05 FBA REF2 MODESEL), the fieldbus references are 32-bit 
integers. The value consists of a 16-bit integer value and a 16-bit fractional value. 
The speed/torque reference scaling is as follows:

Reference Scaling Notes
Torque reference FBA REF / 65536

(value in%)
Final reference is limited by parameters 20.06 MAXIMUM 
TORQUE and 20.07 MINIMUM TORQUE.

Speed reference FBA REF / 65536
(value in rpm)

Final reference is limited by parameters 20.01 MAXIMUM 
SPEED, 20.02 MINIMUM SPEED and 24.12 SPEED 
REFMIN ABS.

Position reference
See parameter group 60 POS FEEDBACK.

Velocity reference
Fieldbus control description
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State diagram
The following presents the state diagram for the FBA communication profile. For 
other profiles, see the User’s Manual of the appropriate fieldbus adapter module.

MAINS OFF

Power ON

from any state

FBA
Communication

Profile

(FBA SW Bit 0 = 1)

n(f)=0 / I=0

(FBA SW Bit 6 = 1)

(FBA CW Bit 16 = 1)

(FBA CW Bit 0 = 1)

OFF1 (FBA CW Bit 4 = 1 

OFF1
ACTIVE

C D

(FBA CW Bit 13 = 0)

RUNNING (FBA SW Bit 3 = 1)

(FBA SW Bit 5 = 1)

from any state

from any state

Emergency Stop
OFF3 (FBA CW Bit 3 = 1 

n(f)=0 / I=0

OFF3
ACTIVE

Emergency OFF
OFF2 (FBA CW Bit 2 = 1 

(FBA SW Bit 4 = 1)OFF2
ACTIVE

RFG: OUTPUT
ENABLED

RFG: ACCELERATOR
ENABLED

B

B C D

(FBA CW Bit 12 = 0)

D

(FBA CW Bit 14 = 0)

A

C

FBA CW = Fieldbus Control Word
FBA SW = Fieldbus Status Word
n = Speed
I = Input Current

(FBA SW Bit 8 = 1)

RFG = Ramp Function Generator
f = Frequency

D

from any state

Fault

(FBA SW Bit 16 = 1)

(FBA CW Bit 8 = 1)

START
INHIBITED

(FBA CW Bits 7 = 1)

READY TO
START

Par. 10.12 = 0

from any state

and FBA CW Bit 0 = 1)

and FBA CW Bit 0 = 1)

and FBA CW Bit 0 = 1)

Par. 10.12 = 1

RUN
DISABLEFAULT

OPERATING

(FBA SW Bit 1 = 0)

(FBA CW Bit 7 = 0)

(FBA CW = xxxx xxxx xxxx xxx0 xxxx 1xxx 1xxx xx10)

(FBA CW = xxxx xxxx xxxx xxx0 xxx0 1xxx 1xxx xx10)

(FBA CW = xxxx xxxx xxxx xxx0 xx00 1xxx 1xxx xx10)

(FBA CW = xxxx xxxx xxxx xxx0 x000 1xxx 1xxx xx10)

E

E
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Starting up the FPBA-01 adapter for different 
communication profiles

Overview
This chapter presents the steps to take during the start-up of the FPBA-01 
PROFIBUS DP Adapter Module with the drive. For more detailed information, see 
PROFIBUS DP Adapter Module FPBA-01 User’s Manual (3AFE68573271 
[English]).

WARNING! Follow the safety instructions given in this manual and in the hardware 
manual of the drive.

Mechanical and electrical installation
• Insert the FPBA-01 into its specified slot in the drive.
• Fasten the screw.
• Plug the fieldbus connector to the module.

Drive configuration
• Power up the drive.
• A parameter must be adjusted to activate the communication: set parameter 

50.01 FBA ENABLE to ENABLE.
• Parameter group 51 shows the status of the FPBA configuration parameters.
• At minimum, set the required node address at parameter 50.02 NODE ADDRESS 

and the communication profile at 5105 PROFILE. Finally, validate the settings 
with 51.27 FBA PAR REFRESH.

Cyclic data handling
With the FPBA-01, both data-consistent and non-consistent communication can be 
used, data-consistent meaning that the whole cyclic data frame is transmitted during 
a single program cycle. Some PLCs handle this internally, but others must be 
programmed to transmit data-consistent telegrams (for more information, see 
PROFIBUS DP Adapter Module FPBA-01 User’s Manual (3AFE68573271 [English]) 
chapter Commmunication). 
Starting up the FPBA-01 adapter for different communication profiles
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Parameter setting examples
This section gives the recommended drive parameter settings for different 
communication profiles. For more information on the communicaton profiles used in 
the communication between the PROFIBUS network, the FPBA-01 module and the 
drive, such as the contents of the Control Word and Status Word and the state 
machines of the profiles, refer to PROFIBUS DP Adapter Module FPBA-01 User’s 
Manual (3AFE68573271 [English]): chapter Communication profiles.
Starting up the FPBA-01 adapter for different communication profiles
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PROFIdrive communication profile (Speed Control Mode) with PPO Type 1
The start/stop commands and reference are according to the PROFIdrive profile 
Speed Control Mode.
A reference value of ±16384 (4000h) corresponds to parameter 25.02 SPEED 
SCALING in forward and reverse directions.

The table below gives the recommended drive parameter settings. 

 *Read-only or automatically detected/set

**Example

The Control Word is used to send commands from a master to a slave unit. The start 
sequence for the parameter example above is given below. 
Control Word: 
47Eh (1150 decimal) => READY TO SWITCH
47Fh (1151 decimal) => OPERATING.

Direction PZD1 PZD2
Out Control Word Speed reference

In Status Word Speed actual value

Drive 
parameter

Name Value Description

50.01 FBA ENABLE ENABLE Communication enable between the drive 
and fieldbus module

50.04 FBA REF1 MODESEL SPEED Fieldbus reference 1 mode selection

10.01 EXT1 START FUNC  FBA External 1 control source selection

24.01 SPEED REF1 SEL FBA REF 1 Fieldbus reference 1 is the source for 
speed reference 1.

34.03 EXT1 CTRL MODE 1 SPEED External 1 control mode 1: Speed

51.01 FBA TYPE PROFIBUS DP* Displays the type of the fieldbus adapter 
module.

51.02 NODE ADDRESS 3** Profibus node address of the fieldbus 
module

51.03 BAUDRATE 12000* Displays current baud rate on the Profibus 
network.

51.04 TELEGRAM TYPE 1 (= PPO1)* Displays telegram type selected by PLC 
configuration tool.

51.05 PROFILE 0 (= PROFIdrive) Control word according to the PROFIdrive 
Speed mode

52.01 FBA DATA IN1 4* Virtual address for Status Word (PZD 1)

52.02 FBA DATA IN2 5 Virtual address for actual value 1 (PZD 2)

53.01 FBA DATA OUT2 1* Virtual address for Control Word (PZD 1)

53.02 FBA DATA OUT2 2 Virtual address for reference 1 (PZD 2)

51.27 FBA PAR REFRESH REFRESH Refreshing parameter settings of the 
module
Starting up the FPBA-01 adapter for different communication profiles
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ABB DRIVES communication profile (Speed/Torque Control Mode) with PPO Type 4
The start/stop commands and reference are according to the ABB DRIVES profile 
Speed Control Mode. 
When Reference 1 (REF1) is used, a reference value of ±20000 (4E20h) 
corresponds to the reference set by parameter 25.02 SPEED SCALING in the 
forward and reverse directions.
When Reference 2 (REF2) is used, a reference value of ±10000 (2710h) 
corresponds to the reference set by parameter 32.04 TORQUE REF 1 MAX in the 
forward and reverse directions.

The table below gives the recommended drive parameter settings.

Direction PZD1 PZD2 PZD3 PZD4 PZD5 PZD6
Out Control Word Speed reference Torque reference Not used

In Status Word Speed actual value Torque actual Not used

Drive 
parameter

Name Setting Description

50.01 FBA ENABLE ENABLE Communication enable between the drive 
and the fieldbus module

50.04 FBA REF1 
MODESEL

SPEED Fieldbus reference 1 mode selection

50.05 FBA REF2 
MODESEL

TORQUE Fieldbus reference 2 mode selection

10.01 EXT1 START FUNC  FBA External 1 control source selection

10.04 EXT2 START FUNC  FBA External 2 control source selection

24.01 SPEED REF1 SEL FBA REF 1 Fieldbus reference 1 is the source for speed 
reference 1

32.02 TORQ REF1 SEL FBA REF 2 Fieldbus reference 2 is the source for 
Torque reference 1

34.01 EXT1/EXT2 SEL C.False External 1 / External 2 selection from 
fieldbus only (bit 11 in the fieldbus Control 
Word)

34.03 EXT1 CTRL MODE 1 SPEED External 1 control mode 1: Speed

34.05 EXT2 CTRL MODE 1 TORQUE External 2 control mode 1: Torque

51.01 FBA TYPE PROFIBUS DP* Displays the type of the fieldbus adapter 
module.

51.02 NODE ADDRESS 3** Profibus node address of the fieldbus 
module.

51.03 BAUDRATE 12000* Displays current baud rate on the Profibus 
network.

51.04 TELEGRAM TYPE 4 (= PPO4)* Displays telegram type selected by the PLC 
configuration tool.

51.05 PROFILE 1(= ABB Drives) Control Word according to the ABB Drives 
profile.

52.01 FBA DATA IN1 4* Status Word (PZD 1)

52.02 FBA DATA IN2 5 Actual value 1

52.03 FBA DATA IN3 6 Actual value 2

53.01 FBA DATA OUT2 1* Control Word
Starting up the FPBA-01 adapter for different communication profiles
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*Read-only or automatically detected/set

**Example

The start sequence for the parameter example above is given below.
Control Word:
47Eh (1150 decimal) => READY TO SWITCH ON
47Fh (1151 decimal) => OPERATING (Speed mode)
C7Fh (3199 decimal)=> OPERATING (Torque mode).

53.02 FBA DATA OUT2 2 Reference 1

53.03 FBA DATA OUT3 3 Reference 2

51.27 FBA PAR REFRESH REFRESH Refreshing parameter settings of the 
module
Starting up the FPBA-01 adapter for different communication profiles
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PROFIdrive communication profile (Positioning Mode) with PPO Type 4
The start/stop commands and reference are according to the PROFIdrive profile 
Positioning Mode. The Position setpoint and velocity reference are defined as 32-bit 
integer values; both are scaled as defined by drive parameter settings.

The table below gives the recommended drive parameter settings. 

Direction PZD1 PZD2 PZD3 PZD4 PZD5 PZD6
Out Control Word (STW1) Position setpoint Velocity reference N/A

In Status Word (ZSW1) Position actual value Velocity actual value N/A

Drive 
parameter

Name Value Description

50.01 FBA ENABLE ENABLE Communication enable between the drive 
and the fieldbus module

50.04 FBA REF1 MODESEL POSITION Fieldbus reference 1 mode selection

50.05 FBA REF2 MODESEL VELOCITY Fieldbus reference 2 mode selection

10.01 EXT1 START FUNC  FBA External 1 control source selection

22.01 SPEED FB SEL ENC1 SPEED** Speed feedback selection

34.02 EXT1 MODE 1/2SEL P.FBA MAIN 
CW.26

External 1 control mode selection. 
Selection is done by START_HOMING bit 
(bit 11 in Profibus Control Word).
Mode 1: Position, Mode 2: Homing

34.03 EXT1 CTRL MODE 1 POSITION External 1 control mode 1:Position

34.04 EXT1 CTRL MODE 2 HOMING External 1 control mode 2: Homing

62.01 HOMING METHOD CAN Methodxx Selects the homing mode. Select the 
appropriate CAN Method.

62.03 HOMING START C.False Homing start from fieldbus only

65.01 POS REFSOURCE FIELDBUS Position reference and speed are read 
from fieldbus.

65.03 POS START 1 C.False Position start 1 from fieldbus only

65.04 POS 1 REF SEL FBA REF 1 FBA reference 1 is the position reference 
source.

65.11 POS START 2 C.False Position start 2 from fieldbus only.

65.22 PROF VEL REF SEL FBA REF2 FBA reference 2 is the velocity reference 
source.

66.05 POS ENABLE C.False Position reference generator is enabled by 
fieldbus only.

70.03 POS REF ENA C.False Position reference enable command from 
fieldbus only

51.01 FBA TYPE PROFIBUS DP* Displays the type of the fieldbus adapter 
module.

51.02 NODE ADDRESS 3** Profibus node address of the fieldbus 
module

51.03 BAUDRATE 12000* Displays current baud rate on the Profibus 
network.

51.04 TELEGRAM TYPE 4 (= PPO4)* Displays telegram type selected by PLC 
configuration tool.
Starting up the FPBA-01 adapter for different communication profiles
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*Read-only or automatically detected/set

Note: By default, fieldbus is not the only control source. See actual signal 2.12 FBA MAIN CW in 
ACSM1 Motion Control Program Firmware Manual for details.

The position setpoint is scaled as follows:

**Example 

The position setpoint and actual values are scaled with the above example values as 
follows: 

Example for velocity setpoint scale: 

**Example 

51.05 PROFILE 4 (= PROFIdrive 
Positioning)

Control Word according to the PROFIdrive 
Positioning mode

52.01 FBA DATA IN1 4* Status Word

52.02 FBA DATA IN2 15 Actual value 1

52.04 FBA DATA IN4 16 Actual value 2

53.01 FBA DATA OUT2 1* Control Word

53.02 FBA DATA OUT2 12 Reference 1

53.04 FBA DATA OUT4 13 Reference 2

51.27 FBA PAR REFRESH REFRESH Refreshing parameter settings of the 
module

Drive parameter Setting

60.05 POS UNIT (Position unit) m**

60.08 POS2INT SCALE 100**

Drive 
parameter

Name Value Description

60.10 POS SPEED UNIT u/s** Unit/s (in this case m/s)

60.11 POS SPEED2INT 100** Scales position speed values to integer values.
Selections: 1/10/100/1000/10000/100000

1000   /  100   =  10.00        m

60.05 POS UNIT
Physical value
60.08 POS2INT SCALE
Setpoint value
Starting up the FPBA-01 adapter for different communication profiles
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The velocity setpoint and actual values are scaled with the above example values as 
follows: 

Pay attention to the following parameters: 

The start sequence for above parameter example is given below:
Control word:
406h (1150 decimal) => READY TO SWITCH ON
40Fh (1039 decimal) => OPERATING
43Fh (1087 decimal)=> OPERATING (Do reject traversing task with no intermediate 
stop.)
47Fh (1151 decimal)=> OPERATING (Activate traversing task.)
C0Fh (3087 decimal)=> OPERATING (Start homing procedure.)

Group Description
90 Encoder selection

91/92/93 Settings of the encoder

1000    /    100   =   10.00        m/s

60.10 POS SPEED UNIT
Physical value
60.08 POS SPEED2INT
Setpoint value
Starting up the FPBA-01 adapter for different communication profiles



29
Starting up fieldbus communication and 
programming the ABB PLC (one-drive system)

What this chapter contains
This chapter presents the steps to take during the start-up of the drive fieldbus 
control with ABB AC500 PLC and PROFIBUS DP adapter module. A system with 
one drive is set up. For a system where two drives are controlled simultaneously, see 
also chapter Starting up fieldbus communication and programming the ABB PLC 
(multi-axis systems), page 105.

For more information on the fieldbus adapter module, such as

• mechanical and electrical installation

• PROFIBUS specific parameters

• components 

• protocols

see PROFIBUS DP Adapter Module FPBA-01 User’s Manual (3AFE68573271 
[English]).

For more information on the PLC, see ABB AC500 PLC manuals.

Safety

WARNING! Follow the safety instructions given in this manual and in the drive 
hardware manual.
Starting up fieldbus communication and programming the ABB PLC (one-drive system)
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Equipment and programs
Equipment used in the examples:

• ACSM1-04 demosuitcase (order code 68836808) containing two ACSM1-04AM-
02A5-4 drives with FPBA-01 PROFIBUS DP Adapter Modules

• AC500 demosuitcase TA510-CASE: AC500 PLC *) equipped with a CPU of type 
PM571 and a communications module, CM572-DP, for communication over 
PROFIBUS DP field.  

Programs used in the examples:

• ACSM1 Motion Control Program version UMFI1480

• ABB DriveStudio PC tool

• AC500 Control Builder PS501 *). Code of the installation CD: 1SAP 190 100 
R0002 C2 V1.3.0 / 11.2008

• PS551-MC PLCopen Motion Control Library *) for AC500. Single license 
1SAP190600R0001. Multiple license 1SAP190600R0101. 

*) Manufacturer ABB STOTZ-KONTAKT GmbH, http://www.abb.de/stotz-kontakt
Starting up fieldbus communication and programming the ABB PLC (one-drive system)
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Start-up flowchart
The steps of the start-up procedure are presented below. Perform the steps from first 
to last.   

No. Task Description / See instruction

ELECTRICAL INSTALLATION In this section, you wire the equipment used in this programming 
example. 

1 Connect the PC RJ-45 cable to 
drive terminal X7.

ACSM1-04 Drive Modules Hardware Manual (3AFE68797543 
[English])
Page 34

2 Connect the PLC fieldbus master 
(CM572-DP) to the fieldbus 
adapter module (FPBA-01) of the 
drive.

Installation of the TA510-CASE, page 34

3 Connect the PC serial port (COM) 
to the PLC programming port.
OR:
Connect the PC Ethernet port to 
the PLC Ethernet port with an RJ-
45 Ethernet cable.
OR:
Connect the PLC serial port to the 
PC USB port with a TK503 
programming cable 

Installation of the TA510-CASE, page 34
TK503 programming cable order code: 1TN968901R1100

SOFTWARE INSTALLATION In this section, you install the programming tools.

1 Install the DriveStudio PC tool if 
not yet installed.

Installing the DriveStudio PC tool, page 35

2 Install the AC500 Control Builder 
PS501 software.

Installing the AC500 Control Builder PS501 software, page 35 

3 Install the PS551-MC Motion 
Control library.

Installing the PS551-MC Motion Control Library, page 37

4 If needed, install additional GSD 
files and libraries.

Installing additional GSD files and libraries, page 38

PROGRAMMING In this section, you set up the communication between the drive 
and the PLC and make the PLC program that controls the drive 
through fieldbus.

–  –  –  O N E -  D R I V E  S Y S T E M  –  –  – 

1 Set the drive control program 
parameters.

In this section you set the drive parameters needed for 
communication with the FPBA-01 fieldbus adapter module.
Setting the drive control program parameters, page 40
Starting up fieldbus communication and programming the ABB PLC (one-drive system)
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2 Set up the communication. In this section, you configure communication between the PLC 
and the drive.
Setting up the communication, page 45
• Create a new project, page 45
• Configure communication with the SYCON fieldbus 

configurator, page 50

3 Program the main program to the 
PLC.

In this section, you program function blocks for communication 
and basic drive control.
Setting up the communication, page 45
• Create a new project, page 45
• Configure communication with the SYCON fieldbus 

configurator, page 50
Programming the PLC main program, page 63
• Load additional libraries for programming assistance, page 63
• Add function block ACSM1_ACCESS_dc, page 66
• Add function block MC_ReadStatus, page 72
• Add function block MC_ReadActualPosition, page 72
• Add function block MC_ReadAxisError, page 72
• Add function block MC_Reset, page 73
• Add function block MC_Power, page 73
• The complete main program is shown here, page 74

4 Program actions to the PLC 
program.

In this section, you program function blocks for motion control.
Programming actions, page 77
• How to create actions, page 77
• Program velocity (MC_MoveVelocity), page 80
• Program stopping (MC_Stop), page 81
• Program positiong (MC_MoveAbsolute), page 82
• Program relative movement (MC_MoveRelative), page 83
• Program homing (MCA_Home), page 84
• Program toggling between two positions, page 84
• Call the actions into the main program, page 87

5 Program the visualization. In this section, you program function blocks for visualizing the 
motion control.
Programming visualizations, page 89
• Create an empty visualization field, page 90
• Create buttons, page 91
• Create indicators, page 95
• Create visuaization elements, page 96

6 Run and test the program. In this section, you run and test the program that you have made.
Running and testing the program, page 99
• Load the program to the controller, page 99
• Test the program, page 102

No. Task Description / See instruction
Starting up fieldbus communication and programming the ABB PLC (one-drive system)
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–  –  –  TWO - D R I V E  S Y S T E M  –  –  –

Set up the communication.
Program the main program to the 
PLC.
Program actions to the PLC 
program.
Program the visualization.
Run and test the program.

In this section, you program additional function blocks for the 
second drive for communication and basic drive control, and 
program additional actions and visualizations, and run and test the 
program.
Setting up the communication, page 105
• Configure communication with the SYCON fieldbus 

configurator, page 106 
Programming the PLC main program, page 116
Programming actions, page 120
Programming visualizations, page 123
Running and testing the program, page 124

No. Task Description / See instruction
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Connections

ACSM1-04

1 2 3 4

5

6 7 8 9

Installation of the TA510-CASE

24 V DC input socket

24 V DC on/off switch

Analog potentiometer

Digital switches

Programming port

CM572-DP communication module

CPU unit PM571

Analog module AX522

Remote digital I/O module DC505-FBP

1

2

3

4

5

6

7

8

9

FPBA-01

Connections for the setup in section Starting 
up fieldbus communication and programming 
the ABB PLC (multi-axis systems), page 105
Note: Both drives are followers/slaves for the 
communication module of the PLC. 

PC:
- DriveStudio
- AC500 Control Builder PS501

COM
Starting up fieldbus communication and programming the ABB PLC (one-drive system)
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Installing the DriveStudio PC tool
Insert the DriveStudio installation CD into the CD drive of your the PC. Follow the 
instructions given by the installation program.

For more information, see DriveStudio online Help folder DriveStudio: Installing and 
uninstalling.

Installing the AC500 Control Builder PS501 software
1. Insert the AC500 Control Builder PS501 installation CD into the CD drive of your 

PC. Click the Read me first button and read the instructions.

2. Click the Installation PS501 button.
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3. Click the Read me for installation button and read the instructions.  

4. Click the Step 1: Installation Control Builder PS501 button. Follow the 
instructions.  

5. Click the Step 2: Installation Fieldbus Configuration SYCON.net button. 
Follow the instructions.

6. Click the Installation GSD and ESD files button. Follow the instructions.

7. Click the Opt. 1: Installation CodeSys Service Tool.
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Installing the PS551-MC Motion Control Library
Insert the PS551-MC Motion Control Library for AC500 (code: 1SAP190600R0001) 
installation CD into the CD drive of your the PC. If the installation does not start 
automatically, double-click setup.exe.  
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Installing additional GSD files and libraries
The GSD file DP-V0 for the FPBA-01 fieldbus adapter module (ABB0959.gsd) is 
included in the PS551-MC Motion Control Library CD and was installed in the 
previous step.

The GSD files DP-V0 and DP-V1 for FPBA-01 can also be found at the 
manufacturer’s website. Go to www.abb.com and select Product Guide / Drives / 
Drive Options / Fieldbus Options. From the Please select category list, select 
“..FPBA - PROFIBUS (3)”. 
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If needed, copy additional GSD files to the following folder in your PC:
C:\Program Files\Hilscher GmbH\SYCONnet\ABBPBGenericSlaveDTM\GSD.  
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Step Setting the drive control program parameters
This section lists the ACSM1 Motion Control Program parameter settings that you 
need to do for successful communication with the FPBA-01 fieldbus adapter 
module. If needed, set also other parameters to meet the application needs. 

For more information on the parameters, refer to ACSM1 Motion Control Program 
Firmware Manual (3AFE68848270 [English]). 

For advice on using the DriveStudio, refer to the DriveStudio online Help.

1. Open the DriveStudio.

2. Set the parameters as shown below.    
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Step Setting the drive control program parameters
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Tool/Step Setting up the communication
For setting up communication between the PLC and the drive, first, create a new 
project. After that, you can open the SYCON.net configuring tool and configure the 
communication.
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Create a new project

1. Open the AC500 Control Builder PS501 programming tool by double-clicking the 
icon:

2. Select from the File menu New. -> Dialog box Target settings opens.

3. In the Configuration: box, select AC500 PM571. Click OK.  

Installation path: 
C:\Program Files\3S Software\CoDeSys V2.3\Codesys.exe
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4. In the New POU dialog box, select as shown below.  

5. -> The programming view opens. Open the Resources field by clicking its tab. 

Tool/Step Setting up the communication
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6. In the Resources folder, double-click PLC Configuration. 

7. In the PLC Configuration dialog box, click the plus sign to open the AC500 folder. 

Tool/Step Setting up the communication
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8. Right-click the Couplers[FIX] folder. Select Append Subelement and CM572 - 
External-PROFIBUS DP Master….   
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9. In the Couplers[FIX] folder, right-click the Internal - none[SLOT] file and select 
Replace element and PM5x1-ETH - Internal-Ethernet.  

10. From the File menu, select Save as and name the project. Click Save. 
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Configure communication with the SYCON fieldbus configurator

1. Open the project that you created.

2. Click the Resources tab to show the Resources folders.

3. Under Tools, double-click SYCON.net <R>.  
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4. -> The SYCON.net tool opens:

5. From the Network menu, select the Device Catalog… command. Click the 
Reload button. -> PROFIBUS options appear in the ABB Oy folder. Click OK.    
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6. Drag and drop CM572-DPM on the green line. In the netConnect-Driver 
Parameter dialog box, select 1 for the Board no: box. This is because the CM572-
DP communications module is installed next to the CPU on the left-hand side in the 
installation example of this manual.  
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7. Drag and drop the FPBA-01 DP-V0 on the purple line.   
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8. In the netDevice field, right-click the CM572-DPM icon. Select Configuration. In 
the Navigation area field, click 3S Gateway Driver. Click the Gateway 
Configuration button.       

9. In the Communication Parameters dialog box, set the communication parameters 
according to the serial port of your PC. See Appendix A - How to find out the serial 
communication parameter values of your PC?.
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10. In the Pages Three-View, click Device Assingnment. Activate the device by ticking 
it.  

11. In the Pages Tree-view, click Configuration / Bus Parameters. In the Bus 
Parameters dialog box, set the Baud Rate. If there is warning sign, click the Adjust 
button and set the other timing parameters.  
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12. In the Pages Tree-view, click Station Table under Configuration. Set the station 
address for the FPBA-01. Click the Apply button and then OK.
Note: The station address here must be the same as the value of Parameter 
51.02 FBA PAR2 in the drive control program. Set parameter Parameter 51.02 FBA 
PAR2 with DriveStudio.  
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13. Right-click the ABB Drives FPBA-01 icon connected to the purple line in the 
netDevice field. In the Navigation area field, click Modules in the Configuration 
folder. In the Available modules: box, select PPO-05. Click the Insert button and 
then Apply and OK.  
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14. In the Configuration folder, click Parameters. Set the values of parameters Fail Safe 
mode and Control-zero mode as shown below.  
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15. In the netConnect field, click PPO-5, 4PKW + 10 PZD <Slot 1>. -> A list of inputs 
and outputs appears.   
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16. Name the signals. In this example configuration, Input 1 is named field_in1 and 
Output 1 field_out1.
Note: You can name all signals here and they will be automatically in use in the 
Control Builder.  

17. Check that the PLC is in the Stop state (Stop in the display). 

Note: The downloading is not possible if the PLC is in the Run state. 

18. Download the communication configuration to the PLC: first, right-click the CM572-
DPM icon and, then click Download.  
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19. When the downloading is completed, right-click the CM572-DPM icon and then 
click Disconnect. 

20. Save the project with the Save command under the File menu.

21. Close the SYCON.net tool.
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Global variables. 
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Tool/Step Programming the PLC main program
In this section, you program the PLC main program which contains function blocks 
for communication and basic drive control.

For detailed function block descriptions, refer to

• CoDeSys Help (Press F1 in CoDeSys software)

• User Manual for PLC Programming with CoDeSys 2.3 by 3S – Smart Software 
Solutions GmbH

For ACSM1 PLCopen function blocks, refer to

• User Manual for PS551-MC (Motion Control library for ABB PLC AC500) 
according to Technical Specification PLCopen – Technical Committee 2 – Task 
Force; Function Blocks for motion control.
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Load additional libraries for programming assistance

It is necessary to load additional libraries to make additional function blocks active.

1. Click the Resoures tab. Double-click the Library Manager.    

2. From the Insert menu, select Additional libraries….
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3. Select the following libraries and click Open.  

Tool/Step Programming the PLC main program
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4. Double-click the PS551-MC folder and select the following libraries. Click Open. 

Note: If you cannot see the PS551-MC folder, you have copied the motion control 
libraries to another folder, or you have not copied them at all. Go to the location 
where you have pasted the libraries, or copy the libraries from the installation CD to 
the following folders:  

C:\Program Files\Common Files\CAA-Targets\ABB_AC500\Library
C:\Program Files\Common Files\CAA-Targets\ABB_AC500\AC500_V12\Library 
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5. In this example, the following libraries were inserted. 

Add function block ACSM1_ACCESS_dc

ACSM1_ACCESS_dc is an interface block that converts the PLC commands to the 
control word format of the ACSM1. The control word is in PROFIdrive positioning 
mode.

1. Click the POUs tab. In the POUs field, double-click PLC_PRG(PRG). -> The Box 
tool for adding function blocks appears in the tool bar. Click the Box button. 
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2. Replace the default text AND with text acsm1_access_dc. Now, the CoDeSys 
program recognizes the function block and the block appearance changes 
automatically.   

3. Name the function block access_axis1 and press Enter.   
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4. -> The Declare Variable assistant appears. In the Class dialog box, select 
VAR_GLOBAL which denotes global variables. The content of box Type is 
configured automatically to ACSM1_ACCESS_dc. Click OK.   

Note 1: If you want to call Declare Variable assistant again, click on the demanded 
variable and press Shift+F2.
Note 2: When defining inputs, you can use help of Input assistant. Click on the 
demanded input and press F2.

5. Configure inputs OFF1, OFF2 and OFF3. Name the fields Off1, Off2 and Off3 and 
press Enter. The program configures the Type of these inputs automatically to 
BOOL and the Class to VAR. Click OK. Inputs RESET_POS_SYS and ROLLOVER 
are left blank.  
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6. Configure input axis. Name it axis1 and press Enter. Class: VAR_GLOBAL. Type: 
AXIS_REF. Note: AXIS_REF is not configured automatically, you must type it. Click 
OK.  

7. Select the left-hand side of input field_in. Click the Box button in the tool bar. Name 
the new function block ADR which denotes address. Press Enter. Repeate the 
same for input field_out.
Note: Inputs field_in1 and field_out1 were configured with SYCON.net on page 60.      
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8. In this section a new program row is made before the access_axis1 block. This is 
because the state of input switches Off1, Off2 and Off3 must be TRUE before 
starting block access_axis1 when the program is run.

Right-click somewhere in the blank area to open the following menu and select 
Network (before). -> A new programmable area (program row 0001) is made.  

The switches have to go to the TRUE state in the following order: Off2, Off3 and 
Off1. They cannot turn on immediately, one after another, so add delay function 
blocks (TON) with a delay time of 200 ms.
In case of errors, output ERR_REMOTE has to be evaluated before start. This is 
done by block AND with an inverted input. To invert the input, right-click on the input 
and select Negate. 
Off1_3 is a switch which is later used starting the drive when the program is run. It 
is a global variable (Class: VAR_GLOBAL; Type: BOOL).

Tool/Step Programming the PLC main program
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The program made so far is shown below.   

Right-click in the blank area and select Network (after) from the menu. Add the 
following blocks to the main program: MC_ReadStatus, MC_ReadActualPosition, 
MC_ReadAxisError, MC_Reset, MC_Power. Configuring the blocks is described 
below.

Tool/Step Programming the PLC main program
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Add function block MC_ReadStatus

This function block returns in detail the status of the axis with respect to the motion 
currently in progress. 

Name the block mc_reads. Press Enter. Class: VAR; Type: MC_ReadStatus. The 
block must be enabled all the time -> name input Enable TRUE. Name input Axis 
axis1 which is already configured.    

Add function block MC_ReadActualPosition

This function block returns the actual position.

Name the block mc_readpos. Press Enter. Class: VAR; Type: 
MC_ReadActualPosition. The block must be enabled all the time -> name input 
Enable TRUE. Add global variable actual_pos_axis1 for later use in visualization, 
Class: VAR_GLOBAL, Type: LREAL.

Add function block MC_ReadAxisError

This function block describes general axis errors not related to the function blocks.

Class: VAR, Type: MC_ReadAxisError.   
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Add function block MC_Reset

This function block makes the transition from state ErrorStop to STANDSTILL by 
resetting all internal axis-related errors. It does not affect the output of the function 
block instances. 

Class: VAR, Type: MC_Reset. Add global variable reset_axis1 for switching 
purposes, because the reset block cannot be active constantly, 
Class: VAR_GLOBAL, Type: BOOL.    

Add function block MC_Power

This function block controls the power stage on or off.

Class: VAR, Type: MC_Power. Add global variables enable_axis1 and 
power_status_axis1 for start-up and visualization, Class: VAR_GLOBAL, Type: 
BOOL. 
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The complete main program is shown here

The complete program is shown below. The local variables are shown in the right-
hand-side top field.   

The global variables are shown below when the Resources field is clicked open.      
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View of the main program rows:      
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Tool/Step Programming actions
In this section, you program actions and add them to the PLC main program. 
Actions are needed for controlling the motor movement. PLCopen library offers 
many simple and very useful functions for the ACSM1.

For detailed function block descriptions, refer to

• CoDeSys Help (Press F1 in CoDeSys software)

• User Manual for PLC Programming with CoDeSys 2.3 by 3S – Smart Software 
Solutions GmbH

For ACSM1 PLCopen function blocks, refer to

• User Manual for PS551-MC (Motion Control library for ABB PLC AC500) 
according to Technical Specification PLCopen – Technical Committee 2 – Task 
Force; Function Blocks for motion control.
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How to create actions

1. In the POUs field, right-click PLC_PROG(PRG) and select Add Action.     
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2. Name the action for example velocity. Select FBD for the programming language. 
Click OK. 

3. -> An empty programming space appears.  

Tool/Step Programming actions
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4. Create separate actions which are needed in the program for example homing, 
position_toggle, positioning, relative, stop and velocity.  

5. Program the actions in the same way as you programmed the function blocks in the 
main program. For example, under action velocity there will be function block 
MC_MoveVelocity. For programming the blocks, see the next steps.    

Tool/Step Programming actions
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Program velocity (MC_MoveVelocity)

This Function Block commands a never ending controlled motion at a specific 
velocity. 

By clicking the Box tool button, insert a new box. Replace the default text AND with 
MC_MoveVelocity. Name the block, for example, movevelo1, Class: VAR, Type: 
MC_MoveVelocity. Name the Execute input velo1, Class: VAR_GLOBAL, Type: 
BOOL. 

Define inputs Velocity, Acceleration and Deceleration with numeric values as 
shown in the window below, or declare them static values in the main program local 
variable list by writing, for example, the following lines to the list. 

Acceleration: LREAL:=1000;

Deceleration: LREAL:=1000;

Velocity1: LREAL:=200;

(Note: For editing the variable list, double-clicking PLC_PROG(PRG) in the POUs 
field, see page 74.)

Name Direction either POSITIVE or NEGATIVE.

Leave Jerk and BufferMode blank. 

Input Axis defines the controlled axis. Name it axis1.   

See the next page.
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The block in the previous picture runs axis1 constantly at velocity 200. 

The speed and position scaling is defined by setting drive control program 
parameters of group 60 POS FEEDBACK, see page 42. With the settings on page 
42, a speed reference of 1000 corresponds to a speed of 1000 rpm that means 
1000 motor axis rotations per minute. 

Program stopping (MC_Stop)

This function block commands a controlled motion stop and transfers the axis to the 
STOPPING state. The block aborts any ongoing function block execution. While the 
axis is in the STOPPING state, no other function block can perform any motion on 
the same axis. After the axis has reached the zero velocity, the Done output is set 
to TRUE immediately. The axis remains in the STOPPING state as long as the 
Execute input remains TRUE or the zero velocity is not yet reached. As soon as 
output Done is set and input Execute is FALSE, the axis goes to the STANDSTILL 
state. For the states, refer to the state machine (Axis StateMachine) on page 102.

By clicking the Box tool button, insert a new box. Replace the default text AND with 
MC_Stop. Name the block, for example, stop1, Class: VAR, Type: MC_Stop. Name 
input Execute stop_axis1, Class: VAR_GLOBAL, Type: BOOL.

Define input Deceleration with a numeric value. 

Leave Jerk and BufferMode blank.

Input Axis defines the controlled axis. Name it axis1. 
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Program positiong (MC_MoveAbsolute)

This function block commands a controlled motion to a specified absolute position.

By clicking the Box tool button, insert a new box. Replace the default text AND with 
MC_MoveAbsolute. Name the block, for example, absolute1, Class: VAR, 
Type: MC_ MoveAbsolute. Name input Execute move_pos1, Class: 
VAR_GLOBAL, Type: BOOL.

Define inputs Position, Velocity, Acceleration and Deceleration with numeric values. 

Leave Direction, Jerk and BufferMode blank. 

Input Axis defines the controlled axis. Name it axis1.

The following block drives axis1 to position 1000.  
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Program relative movement (MC_MoveRelative)

This function block commands a controlled motion of a specified distance relative to 
the actual position at the time of the execution.

By clicking the Box tool button, insert a new box. Replace the default text AND with 
MC_MoveRelative. Name the block, for example, relative1, Class: VAR, Type: MC_ 
MoveRelative.

Name the Excecute input move_rel1, Class: VAR_GLOBAL, Type: BOOL. 

Define inputs Position, Velocity, Acceleration and Deceleration with numeric values. 

Leave Jerk and BufferMode blank. 

Input Axis defines the controlled axis. Name it axis1.

Name input Direction either POSITIVE or NEGATIVE.   
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Program homing (MCA_Home)

This function block commands the axis to perform the Search home sequence. The 
details of this sequence depend on the drive manufacturer and can be set by the 
axis parameters. The Position input is used to set the absolute position when a 
reference signal is detected. The execution of this function block comes to an end 
at the STANDSTILL state. 

By clicking the Box tool button, insert a new box. Replace the default text AND with 
MCA_Home. Name the block, for example, home1, Class: VAR, Type: MC_ 
MoveRelative.

Name the Excecute input move_home1, Class: VAR_GLOBAL, Type: BOOL. 

Input Axis defines the controlled axis. Name it axis1.

Note 1: This function block is not working with FPBA-01 version 200D or older. 

Program toggling between two positions

This section presents an example of a function block program for toggling between 
two positions. At the page 81, action position_toggle was created. Write the 
program below into the action position_toggle. 
Name the Excecute input move_toggle1, Class: VAR_GLOBAL, Type: BOOL.
Name variable pos_step, Class: VAR, Type: WORD. 

See the next page for the descriptions of the program rows.
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Row 0001
This section is the main switch. When the drive needs to be stopped, function block 
SEL sets the value of output pos_step to 0. Otherwise the value of output pos_step 
remains unchanged and the program keeps running.
Row 0002
This section starts up the whole program sequence and repeats it as long as the 
value of input move_toggle1 is TRUE.

Block trigger2 is needed for the first start-up. The block triggers one time when the 
value of input move_toggle1 turns to TRUE.

The output of block OR is TRUE, when the trigger block output is TRUE. In this 
case, block SEL selects value 1 to output pos_step.

Row 0003
This section compares the value of input pos_step with 1. When the values match, 
block EQ returns the value of its output to TRUE.
TON block pause1 sets its output movement1 to TRUE with a delay of one second. 
The program runs through sections 4 and 5, there is nothing to do. 
Row 0006
This section executes MC_MoveAbsolute block togglemove1. The block moves 
axis1 to position 800. After the movement, the value of output togglemove1.Done is 
TRUE.
Now the program runs through sections from 7 to 3, there is nothing to do.
Section 4 is executed.
Row 0004
The values of inputs move_toggle1 and togglemove1.Done in the AND block are 
TRUE. Block SEL sets the value of its output pos_step to 2.
Row 0005
This section is similar to section 3. Block EQ compares the value of its input 
pos_step with 2. Now, the values match and the output of block EQ returns to 
TRUE.
TON block pause2 sets its output movement2 to TRUE with a delay of one second
The program runs through section 6, there is nothing to do.
Row 0007
This block executes MC_MoveAbsolute block togglemove2. The block moves axis1 
to position -1200. After the movement, the value of output togglemove2.Done is 
TRUE.
The program starts the whole sequence again from row 0002. The toggling is 
continuous as long as the value of input move_toggle1 is TRUE.
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Call the actions into the main program

To activate the actions that you created, call them into the main program: 
• In the POUs field, double-click PLC_PRG(PRG).

• Right-click and select Network (after) from the opening menu.

• Click the Box tool button and name the appearing box homing.

• Repeat the procedure for the other actions and give the boxes the same names 
as in the configuring steps before.

See the next page for the program rows.
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The action boxes are shown at the end of the main program as follows.  
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Tool/Step Programming visualizations

C
oD

eS
ys

In this section, you program visualizations. By visualizations, you create the user 
interface for the PLC program: buttons, switches and indicators for measuring, 
viewing and controlling the movement. The PS551-MC Motion Control Library for 
ABB PLC AC500 also contains ready-made visualization elements for the ACSM1, 
for example, the ACSM1 MainControlWord and Axis StateMachine.
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Create an empty visualization field

Click the Visualization tab. Right-click the Visualizations folder. From the menu 
opening, select Add Object…. Name the New Visualization, for example, visu1 
and click OK.   
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Create buttons

Create buttons for the needed switches, for example, for each global variable:  

In our example, buttons are made for off1_3, enable_axis1, reset_axis1, velo1, 
stop_axis1, move_pos1, move_home_axis1, move_rel1 and move_toggle1.

How to create and configure a button

1. In the upper tool bar, click the OK button and drag with the cursor a rectangle in 
visualization field. 
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2. Configure the button as follows. Right-click the button. From the menu opening, 
select Configure.

3. In the Category: dialog box, select Text. To the Text Content: dialog box, write the 
name for the button, for example, Off1_3 which indicates the action the button will 
perform.
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4. In the Category: dialog box, select Input. Under Input, tick Toggle variable and 
write the name of the input to the dialog box, in this case global variable off1_3. 
Click OK.

Note: When defining inputs, you can use help of Input assistant. Click on Toggle 
variable field and press F2.  

Now, you have created a button with which you can switch the value of global 
variable off1_3 between FALSE and TRUE. 
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5. After making all buttons, the visualization field looks like this. Table below indicates 
the buttons and variables to which the buttons must be toggled.    

Tool/Step Programming visualizations

Button Toggle variable
Off1_3 off1_3
Enable enable_axis1
Velocity 1 velo1
Position 1 move_pos1
Relative 1 move_rel1
Toggle move move_toggle1
Stop stop_axis1
Reset reset_axis1
Homing move_home1
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Create indicators

1. In the upper tool bar, click the Bar display button and drag with the cursor a bar in 
visualization field. -> Configure bar display dialog box opens. Click the Varible/
Scale button.   

2. Set the scale. Write the name of the indicated variable (actual_pos_axis1 in this 
case) in the Variable: box. Click OK and OK. -> The indicator has been created.   

Tool/Step Programming visualizations
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Create visuaization elements

1. Visualization elements are ready-made visualization components.

In the upper tool bar, click the Visualization button and with the cursor drag a 
rectangle in the visualization field. In the opening Select Visualization dialog box, 
select the visualization, MC_VISU_ACSM1_mcw, in this case. Click OK.  

Tool/Step Programming visualizations
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2. Double-click the created element. In the Visualization dialog box that opens, click 
the Placeholder… button. In the Replace placeholders dialog box, write 
.access_axis1 to the Replacement field. This points to the access_axis1 function 
block. Click OK and OK.  

Tool/Step Programming visualizations
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3. Add other elements in the same way as described above.

Note: In the Replacement field, write .access_axis1 for the ACSM1 main control 
word and main status word visualizations. Write .axis1 for the Axis actual values 
and Axis state machine values visualizations. The replacement points always to the 
values that the visualization is presenting.

Here is an example of the finished visualization.    

Tool/Step Programming visualizations
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Tool/Step Running and testing the program

C
oD

eS
ys In this section, you download the program to the PLC. Thereafter, you can run the 

program and test it.

Load the program to the controller

1. Turn the drive on with the I/O switch of the demosuitcase.

2. Turn the PLC on with the on/off switch in its demosuitcase. For the location of the 
on/off switch, refer to the photo on page 34.
Starting up fieldbus communication and programming the ABB PLC (one-drive system)
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3. From the Online menu, select Communication Parameters…. Check that the 
communication parameters correspond to the serial port of your PC (see Appendix 
A - How to find out the serial communication parameter values of your PC?).    

4. Open the AC500 Control Builder PS501 programming tool by double-clicking the 
CoDeSys icon in the desktop of your computer.

5. Click the Visualization tab. 

Tool/Step Running and testing the program
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6. From the Online menu, click Login. The program asks you to download the 
program to the controller. Click Yes.  

If you get a communication error message,  

Check the cables and connections. From the Online menu, select 
Communication Parameters… and remove irrelevant communication 
parameters. Configure the communication with the SYCON.net again and 
download the configuration as described above. To find out the communication 
parameter values of your PC, see Appendix A - How to find out the serial 
communication parameter values of your PC?.

7. From the Online menu, click Run. -> Now, your program is active and you can run 
the functions.

Tool/Step Running and testing the program
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Test the program

1. Start the drive by clicking the Off1_3 button and, after that, the Enable button. 
-> The drive should start and the values of the first six ACSM1 MainControlWord 
bits should change to TRUE. 

Tool/Step Running and testing the program
Starting up fieldbus communication and programming the ABB PLC (one-drive system)



103
 

2. Test the other actions that you have made by clicking the action buttons. Velocity 1 
is running in the following picture.   

Tool/Step Running and testing the program
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Starting up fieldbus communication and 
programming the ABB PLC (multi-axis systems)

What this chapter contains
This chapter presents the additional steps compared to the ones in the previous 
chapter that you must take during the start-up of the drive fieldbus control with ABB 
AC500 PLC and PROFIBUS DP adapter module in a multi-axis system. A system 
with two drives is set up here.

Equipment and programs
The equipment and programs used in this chapter are the same as in the previous 
chapter of this manual. They are listed under Equipment and programs, page 30.  

 

Tool/Step Setting up the communication
Proceed in the start-up as described earlier in this manual up to page 50.
Starting up fieldbus communication and programming the ABB PLC (multi-axis system)
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Configure communication with the SYCON fieldbus configurator

1. Open the project that you created.

2. Click the Resources tab to show the Resources folders.

3. Under Tools, double-click SYCON.net <R>.  

Tool/Step Setting up the communication
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4. -> The SYCON.net tool opens:

5. From the Network menu, select the Device Catalog… command. Click the 
Reload button. -> PROFIBUS options appear in the ABB Oy folder. Click OK.    

Tool/Step Setting up the communication
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6. Drag and drop CM572-DPM on the green line. In the netConnect-Driver 
Parameter dialog box, select 1 for the Board no: box. This is because the CM572-
DP communications module is installed next to the CPU on the left-hand side in the 
installation example of this manual.  

7. Drag and drop the FPBA-01 DP-V0 two times on the purple line.   

Tool/Step Setting up the communication
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8. In the netDevice field, right-click the CM572-DPM icon. Select Configuration. In 
the Navigation area field, click 3S Gateway Driver. Click the Gateway 
Communication button.       

9. In the Communication Parameters dialog box, set the communication parameters 
according to the serial port of your PC. See Appendix A - How to find out the serial 
communication parameter values of your PC?. 

Tool/Step Setting up the communication
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10. In the Pages Three-View, click Device Assignment. Activate the device by ticking 
it.  

11. In the Pages Tree-view, click Configuration / Bus Parameters. In the Bus 
Parameters dialog box, set the Boud Rate. If there is warning sign, click the Adjust 
button and set the other timing parameters.  

Tool/Step Setting up the communication
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12. In the Pages Tree-view, click Station Table under Configuration. Set the station 
address for the FPBA-01 fieldbus adapter modules. Click the Apply button and 
then OK.
Note: The station addresses here must be the same as the value of Parameter 
51.02 FBA PAR2 in the drive control program. Set parameter Parameter 51.02 FBA 
PAR2 with DriveStudio.  

Tool/Step Setting up the communication
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13. Right-click the ABB Drives FPBA-01 icon connected to the purple line in the 
netDevice field. In the Navigation area field, click Modules in the Configuration 
folder. In the Available modules: box, select PPO-05. Click the Insert button and 
then Apply and OK. Do this for the both FPBA-01 units.   

Tool/Step Setting up the communication
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14. In the Configuration folder, click Parameters. Set the values of parameters Fail Safe 
mode and Control-zero mode as shown below. 

Tool/Step Setting up the communication
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15. In the netConnect field, click PPO-5, 4PKW + 10 PZD <Slot 1>. -> A list of inputs 
and outputs appears.

Name the signals. In this example configuration, Input_1 is named field_in1 and 
Output_1 field_out1.
Note: You can name all signals here and they will be automatically in use in the 
Control Builder.    

16. Name the signals in the same way for the second drive: Input_1 for field_in2 and 
Output_1 field_out2.  

Tool/Step Setting up the communication
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17. Check that the PLC is in the Stop state (Stop in the display). 

Note: The downloading is not possible if the PLC is in the Run state. 

18. Download the communication configuration to the PLC: first, right-click the CM572-
DPM icon and, then click Download.  

19. When the downloading is completed, right-click the CM572-DPM icon and then 
click Disconnect. 

20. Save the project with the Save command from the File menu.

21. Close the SYCON.net tool.

Tool/Step Setting up the communication
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Tool/Step Programming the PLC main program
Programming of the PLC main program is described earlier in this manual 
beginning from page 63. For a system with two drives, program similar function 
blocks for both drives. In this case, main program for both drives is programmed 
inside actions, this is done to achieve more clear presentation of the program.

Note: Name every function block uniquely, otherwise the program will not work 
correctly.

A list of the Local variables is shown below.  
Starting up fieldbus communication and programming the ABB PLC (multi-axis system)
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A list of the Global variables is shown below.   

Tool/Step Programming the PLC main program
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The finished main program is shown below.  

Tool/Step Programming the PLC main program
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Tool/Step Programming the PLC main program
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Tool/Step Programming actions
Programming of the actions is described earlier in this manual beginning from page 
77. For a system with two drives, program similar actions for the both axes: axis1 
and axis2.  
Starting up fieldbus communication and programming the ABB PLC (multi-axis system)
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The program shown below controls a two-axis toggle movement. For a description 
of the toggle movement, refer to section Program toggling between two positions, 
page 84.    

Tool/Step Programming actions
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Add the action block toggle_movement to the main program. 

Tool/Step Programming actions
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Tool/Step Programming visualizations
Programming of the visualizations is described earlier in this manual beginning 
from page 89. An example visualization is shown below.  
Starting up fieldbus communication and programming the ABB PLC (multi-axis system)
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Tool/Step Running and testing the program

C
oD

eS
ys Load and test the program as described earlier in this manual beginning from page 

99.

Clicking order:

Click first both Off1_3 buttons and the both Enable buttons. -> The drives should 
start. Click the Toggle move button. -> The toggle movement should start.
Starting up fieldbus communication and programming the ABB PLC (multi-axis system)
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Example program for a two-axis loading machine

What this chapter contains
This chapter presents an example sequence program which controls a loading 
machine with two axes.  

Description of the machine
The machine loads boxes. The first axis loads ten items to each box and the second 
axis moves the filled boxes forward on a conveyor.

Diagram of the system

Description of the program

Loading sequence
The first axis toggles between positions 50 and 0. Every time when it does a forthward 
movement, it pushes one item to a box. Thereafter, the axis moves backwards. When 
the first axis has finished one forward-backward movement, the second axis makes 
a movement of distance 10, and the next empty slot in the box comes in front of the 
machine's loading point. This way, the machine fills the 10 slots of the box. 

When the loading sequence has repeated 10 times, the box is full. The program, then, 
moves the box a distance of 1000. This is the distance between the boxes. After this, 
the sequence starts again and fills the next box. 
Example program for a two-axis loading machine
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Program
The program for the toggle movement control is shown below.  
Example program for a two-axis loading machine
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Example program for a two-axis loading machine
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Appendix A - How to find out the serial 
communication parameter values of your PC?

What this chapter contains
This chapter instructs how to find out the serial communication parameter values of 
your PC.

Tool/Step How to find out the serial communication parameter values 
of your PC?
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1. Go to Windows Control Panel and click the System icon. 
Appendix A - How to find out the serial communication parameter values of your PC?
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2. Click the Hardware tab and then the Device Manager button.    

3. In the Ports (COM & LPT) folder, click Communications Port, which is connected to 
AC500, in this case port (COM1).    

Tool/Step How to find out the serial communication parameter values 
of your PC?
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4. The communication port settings are shown.   

Tool/Step How to find out the serial communication parameter values 
of your PC?
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Further information

Product and service inquiries
Address any inquiries about the product to your local ABB representative, quoting 
the type designation and serial number of the unit in question. A listing of ABB sales, 
support and service contacts can be found by navigating to www.abb.com/drives and 
selecting Sales, Support and Service network.

Product training
For information on ABB product training, navigate to www.abb.com/drives and select 
Training courses.

Providing feedback on ABB Drives manuals
Your comments on our manuals are welcome. Go to www.abb.com/drives and select 
Document Library – Manuals feedback form (LV AC drives).

Document library on the Internet
You can find manuals and other product documents in PDF format on the Internet. 
Go to www.abb.com/drives and select Document Library. You can browse the library 
or enter selection criteria, for example a document code, in the search field.

www.abb.com/drives
www.abb.com/drives
www.abb.com/drives
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ABB Oy
Drives
P.O. Box 184
FI-00381 HELSINKI
FINLAND
Telephone +358 10 22 11
Fax +358 10 22 22681
www.abb.com/drives

ABB Inc.
Automation Technologies
Drives & Motors
16250 West Glendale Drive
New Berlin, WI 53151
USA
Telephone 262 785-3200

1-800-HELP-365
Fax 262 780-5135
www.abb.com/drives

ABB Beijing Drive Systems Co. Ltd.
No. 1, Block D, A-10 Jiuxianqiao Beilu
Chaoyang District
Beijing, P.R. China, 100015
Telephone +86 10 5821 7788
Fax +86 10 5821 7618
www.abb.com/drives
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